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How to use this Competency Based Learning Materials (CBLMs) 

  

The module, Maintaining and enhancing professional & technical competency contains 

training materials and activities for you to complete. These activities may be completed as part 

of structured classroom activities or you may be required you to work at your own pace. These 

activities will ask you to complete associated learning and practice activities in order to gain 

knowledge and skills you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or tasks 

you are going to learn how to do. Once you have finished reading the Information 

Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to help 

you know how you are progressing.  If you are unable to answer the questions in the 

Self-Check you will need to re-read the relevant Information Sheet. Once you have 

completed all the questions check your answers by reading the relevant Answer Keys 

found at the end of this module.  

  

4. Next, move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step by 

step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practice the job. You may need to 

practice the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be provided 

where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others in 

the training room. Should you require assistance or clarification please consult your trainer or 

facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved competency 

in the specified learning outcomes. You will then be ready to move onto the next Unit of 

Competency or Module  
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Module Content 
 

 

Module: Use Image Editing Software 

 

Module Descriptor: This module encompasses the necessary knowledge, skills, and attitudes 

(KAS) for image editing software. It specifically includes selecting the image editing tool and 

editing the image using the editing tool. 

 

Nominal Hours: 30 

 

Learning Outcome:  

 

After completion of the module, trainees will be able to:  

 

1. Select the image editing tool. 

2. Edit the image using an editing tool. 

 

Assessment Criteria: 

 

1.1 Appropriate image editing software is selected as required. 

1.2 Necessary plug-ins are installed, and check other requirements. 

 

2.1. The image is opened in layers, and be aware of the legislation. 

2.2. Layers are added to the image as required.  

2.3. Format, colour, brushes, effects and swatches are applied as required. 

2.4. Optimised and previewing of the Image is demonstrated. 

2.5. The image is exported as required. 
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Learning Outcome 1: Select the image editing tool 

Assessment Criteria 

 

1.1 Appropriate image editing software is selected as required. 

1.2 Necessary plug-ins are installed, and check other 

requirements. 

Conditions and 

Resources 

 

1. Applicable tools, utensils, and equipment as prescribed by 

competency standards. 

2. Supply materials  

3. Relevant ingredients  

4. CBLM related to the learning outcome. 

5. Instructions, job sheets, activity sheets, and standard 

operating procedures  

6. Personal protective equipment  

7. Module/reference 

Contents 1 Image Processing Software. 

2 Installing necessary plug-ins. 

Training Materials 

 

1. CBLM 

2. Handouts 

3. Books, Manuals  

4. Module/ Reference  

5. Paper  

6. Pen 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 1: Select the image editing tool 

 

You must perform the learning steps below to achieve the objectives stated in this learning 

guide. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Students will ask the 

instructor about use image 

editing software. 

1. The instructor will provide the learning materials for` 

select the image editing tools. 

2. Read the Information sheet/s 

2. Information Sheet No 1: Select the image editing tool. 

 

• Image Processing Software. 

• Installing necessary plug-ins. 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No 1: Select the image editing tool. 

 

Answer key No 1: Select the image editing tool. 

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Individual Activity Sheet 1 

 

 

  



 

6 
 

Information Sheet 1 Select the image editing tool 
 

Learning Objective: After completing this information sheet, the learners will be able to 

select the image editing tool. 
 

1.1 Image Processing Software. 

1.2 Selecting Image Processing Software. 

1.3 Installing necessary plugins. 

 

1.1 Image Processing Software:  

 

Various commercial and open-source image processing software can be used for various 

image editing and manipulation tasks. Here are some popular examples: 

 

▪ Adobe Photoshop: Adobe Photoshop is 

one of the most well-known and widely 

used image editing software. It offers a 

comprehensive set of tools for image 

processing, including cropping, 

retouching, colour correction, and 

special effects.  

▪ Photoshop Express: A free and easy-to-

use photo editing app that offers a 

variety of basic and advanced editing 

tools. It is a good option for basic photo 

editing tasks, such as cropping, resizing, 

and adjusting brightness and contrast. 
 

▪ GIMP (GNU Image Manipulation 

Program): GIMP is an open-source 

alternative to Adobe Photoshop. It 

provides many similar features and tools 

for image editing and manipulation. 

 

▪ Adobe Lightroom: Adobe Lightroom is 

primarily used for managing and editing 

large photographs collections. It offers 

powerful features for organizing, 

enhancing, and sharing images. 
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▪ Canva: A web-based graphic design 

platform that offers a variety of 

templates and tools for creating 

professional-looking designs. It is a 

good option for creating social media 

graphics, presentations, and other 

marketing materials.  

▪ InPixio: A photo editing software that 

offers a variety of features, including 

photo restoration, background removal, 

and object removal. It is a good option 

for more complex photo editing tasks. 
 

▪ Capture One: Capture One is 

professional-grade image editing 

software popular among photographers. 

It provides advanced tools for image 

editing, raw processing, and tethered 

shooting.  

▪ Ashampoo: A photo editing software 

that offers a variety of features, 

including photo editing, photo collage 

maker, and photo sharing. It is a good 

option for users who want a 

comprehensive photo editing software. 

 

 

 

 
Figure 1: Image Processing Software example 
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These are just a few examples, and many other image-processing software options are available 

depending on your specific requirements and budget. 

 

1.2 Selecting Image Processing Software 

 

When selecting image processing software, several factors should be considered based on 

your specific needs and requirements. Here are some key considerations to help you 

choose the right image-processing software: 

▪ Purpose: Determine the purpose of the software. In this case, you need software for 

professional image editing and enhancement. 

▪ Features: Consider the features you require. You need tools for basic editing (cropping, 

resizing, exposure adjustments), advanced retouching, colour correction, filters, and 

support for RAW files. 

▪ Ease of use: As a professional, you are willing to invest time in learning the software, 

but you also value an intuitive interface and smooth workflow. 

▪ Compatibility: Check if the software is compatible with your operating system (e.g., 

Windows or macOS). Additionally, see if it integrates well with your preferred file 

management and organization software. 

▪ Performance and speed: Look for software that can handle high-resolution images 

efficiently and performs tasks quickly without excessive lag or slowdowns. 

▪ Support and documentation: Ensure that the software offers comprehensive 

documentation, tutorials, and user forums to assist you when needed. Prompt customer 

support is also valuable in case you encounter any issues. 

▪ Cost: Consider your budget. While you are willing to invest in professional-grade 

software, it should offer good value for money and align with your budgetary 

constraints. 

▪ Industry-specific needs: Although you are a photographer, you may not have specific 

industry requirements beyond standard image editing capabilities. 

▪ Reputation and reviews: Research the reputation of various software options. Look 

for reviews from professional photographers or trusted sources to understand their 

experiences and satisfaction levels. 

▪ Trial and experimentation: Take advantage of trial versions or demos of shortlisted 

software options. Spend time experimenting with the tools, editing different types of 

photos, and evaluating how well the software aligns with your workflow and 

preferences. 
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1.2.1 Example software: Adobe Photoshop would be a suitable software option. Here's how 

it matches the considerations: 

▪ Purpose: Adobe Photoshop is widely used for professional image editing and offers 

many features. 

▪ Features: Photoshop provides a comprehensive set of tools for editing, retouching, 

colour correction, filters, and RAW file support. 

▪ Ease of use: While Photoshop has a learning curve, its user interface is well-organized 

and offers customizable workspaces. 

▪ Compatibility: Photoshop is available for Windows and macOS and integrates well 

with Adobe Bridge for file management. 

▪ Performance and speed: Photoshop is known for its efficient performance, even with 

large image files and complex operations. 

▪ Support and documentation: Adobe offers extensive documentation, tutorials, and a 

large user community. Their customer support is generally prompt and reliable. 

▪ Cost: Photoshop is a premium software with subscription-based pricing, but it provides 

excellent value for professionals. 

▪ Industry-specific needs: Photoshop is widely used in photography and offers features 

tailored to photographers' needs. 

▪ Reputation and reviews: Adobe Photoshop have a strong reputation and is highly 

regarded by professional photographers. 

▪ Trial and experimentation: Adobe offer a free trial of Photoshop, allowing you to 

explore its features and evaluate its suitability. 

 

1.3 Installing necessary plugins 

 

Adobe Photoshop is a powerful and widely used image editing software that offers 

professionals and enthusiasts a wide range of features and tools. To enhance its 

functionality and cater to diverse creative needs, Adobe Photoshop supports plugins. 

Photoshop plugins are add-on software modules that integrate seamlessly with the 

Photoshop environment, providing additional features, effects, and capabilities. These 

plugins can be developed by Adobe, third-party developers, or the Photoshop community. 

 

1.3.1 Key Points about Adobe Photoshop Plugins: 
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▪ Functionality Enhancement: Plugins extend the capabilities of Adobe Photoshop by 

adding new tools, effects, and features that may not be available by default. These can 

range from advanced retouching tools to special effects generators. 

 

▪ Third-Party Development: Many plugins are developed by third-party companies or 

individual developers. This results in a vast marketplace of plugins catering to various 

creative needs, such as retouching, 3D modelling, text effects, and more. 

 

▪ Ease of Integration: Plugins seamlessly integrate into the Photoshop interface. Once 

installed, they often appear as additional menu options, panels, or filters within the 

application. 

 

▪ Versatility: There are plugins available for a wide variety of purposes, including photo 

retouching, colour correction, digital painting, graphic design, web design, 3D rendering, 

and more. 

 

▪ Efficiency: Plugins can save time and effort by automating repetitive tasks or offering 

shortcuts to achieve complex effects that might be time-consuming to create manually. 

 

▪ Customization: Some plugins allow users to create and save presets to streamline 

workflows and maintain consistency across projects. 

 

▪ Regular Updates: Developers frequently update plugins to ensure compatibility with new 

Adobe Photoshop versions and add new features based on user feedback. 

 

▪ Community Contribution: Some plugins are developed and shared freely within the 

Photoshop community. This fosters a collaborative environment where users can exchange 

ideas, tools, and techniques. 

 

▪ Security Considerations: When using third-party plugins, it's important to ensure they 

come from reputable sources to avoid potential security risks or conflicts with the 

Photoshop application. 

 

▪ Compatibility: While most plugins are designed to work across different versions of 

Adobe Photoshop, it's essential to check compatibility before installation. 

 

1.3.2 Popular Types of Photoshop Plugins: 

 

▪ Filter Plugins: These add new filters and effects that can be applied to images to achieve 

artistic or creative results. 

 

▪ Brush Plugins: These plugins provide new brush presets, textures, and dynamic brush 

effects for digital painting and design. 
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▪ Automation Plugins: Automation plugins streamline repetitive tasks, such as batch 

processing, resizing, watermarking, and more. 

 

▪ Colour Correction Plugins: These plugins offer advanced colour correction and grading 

tools to enhance and manipulate image colours. 

 

▪ Special Effects Plugins: These plugins create unique effects like lighting, lens flares, 

distortions, and more to add visual impact to images. 

 

▪ 3D Rendering Plugins: For those working with 3D elements, these plugins provide tools 

for creating and rendering 3D objects directly within Photoshop. 

 

Adobe Photoshop plugins significantly contribute to the software's flexibility and 

adaptability. They allow users to explore and experiment with various creative 

possibilities, ultimately enhancing the quality and uniqueness of their work. 

 

1.3.3 How to Install Plug-ins for Adobe Photoshop 

 

Method1: Installing Plugins Manually 

 

➢ Download a plugin. Most plugins are available through the Adobe Creative Cloud 

Marketplace, but you can often find unofficial plugins on third-party sites. Some are 

even free. 

• Check out Adobe's list of third-party plugins 

here: https://helpx.adobe.com/photoshop/kb/plugins.html 

• If you're looking for free Photoshop plugins, check these out: 

• On1 Creative Assets: https://www.on1.com/free/creative-assets 

• The Orange Box: https://www.the-orange-box.com/photoshop-add-ons/ 

• The available plugins from the Adobe Marketplace will need to be downloaded 

and installed through Creative Cloud. 

• Some of the more advanced plugins come with their own installer file. To install 

these plugins, open the installer file once downloaded and follow the 

instructions to complete the installation. 

https://helpx.adobe.com/photoshop/kb/plugins.html
https://www.on1.com/free/creative-assets
https://www.the-orange-box.com/photoshop-add-ons/
https://www.wikihow.com/Install-Plugins-in-Adobe-Photoshop#/Image:Install-Plugins-in-Adobe-Photoshop-Step-1-Version-3.jpg
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Figure 2: Download Photoshop Plugin 

➢ Extract the plugin you downloaded: Most Photoshop plugins come compressed 

inside a RAR or ZIP folder for easy transfer. Right-click on the downloaded file 

and extract it anywhere on your computer. 

 

 

Figure 3: Extract the Plugin for Photoshop 

https://www.wikihow.com/Install-Plugins-in-Adobe-Photoshop#/Image:Install-Plugins-in-Adobe-Photoshop-Step-3-Version-3.jpg
https://www.wikihow.com/Install-Plugins-in-Adobe-Photoshop#/Image:Install-Plugins-in-Adobe-Photoshop-Step-3-Version-3.jpg
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➢ Copy the plugin files you extracted: Copy the entire folder that contains the plugin 

files. Do this by right-clicking on the folder and selecting “Copy” from the context 

menu. 

 

Figure 4: Copy the Plugin for Photoshop 

➢ Open your Adobe Plugins folder. You can typically find the plugins folder at one of 

the following locations depending on if you are using a Windows PC or Mac: 

• Windows: C:\Program Files\Adobe\Adobe Photoshop <year>\Plug-ins 

• Mac: ~/Applications/Adobe Photoshop <year>/Plugins 
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Figure 5: Adobe Plugin Folder 

➢ Paste the extracted plugin folder inside the “Plugins” folder. Right-click an empty 

area in the “Plugins” folder and select Paste. This will install the plugin. 

 

 
Figure 6: Paste in Adobe Plugin Folder 

➢ Launch Adobe Photoshop. Do this by clicking its shortcut icon on the desktop or by 

opening it from the list of applications installed on your computer. You can also launch 

Photoshop from within the Adobe Creative Cloud app. 
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• If Photoshop is open while you copied and pasted the downloaded plugins into 

the Plugins folder, you will need to close the program and restart it. 

 

 
Figure 7: Lunch Adobe Photoshop 

➢ Test the plugins you installed. Select the tools required to use the plugins you 

installed. 

• For example, if you installed brush-style plugins, use the Brush tool to test your 

installed styles. 

 

 
Figure 8: Test Photoshop Plugin 

Popular Photoshop Plugins 

1. Camera Raw: Camera Raw is simply a bare necessity. It’s a plugin that enables you to 

edit raw images, but you can also use it with other file formats, such as JPEG and TIFF.  
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Figure 9: Camera Raw lets you use Photoshop for touch-ups you’d normally do in Lightroom. 

This one is very convenient if you want to skip the constant switching from Lightroom to 

Photoshop because Camera Raw can adjust things you’d normally touch up in Lightroom 

– white balance, tint, contrast, shadows, highlights and many more. This plugin is available 

for both Windows and Mac and is free of charge. 

 

2. Pexels Photoshop Plugin: This plugin can significantly improve your workflow and save 

you time. With Pexels Photoshop Plugin, you can access thousands of free stock 

photography, which you can browse without leaving Photoshop. 

 

 
Figure 10: Pexels Photoshop Plugin lets you browse thousands of free stock images from 

within Photoshop. 

All photos offered are free to use for commercial or personal purposes. The gallery 

constantly expands, with at least 3,000 new free images added monthly. 
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3. ON1 Effects: ON1 Effects supports a huge collection of different presets that you can use 

to enhance your images. This one is great for people who like to experiment a lot and 

would like to achieve a cinematic look or a beautiful B&W photo with one click. 

 

 
Figure 11: With ON1 Effects, you can enhance your images with presets. 

The other good news is that there’s an Opacity slider, so you can always turn the effect 

down if you think it’s too much. ON1 Effects works both as a standalone application and 

as a free plugin for Photoshop and Lightroom. 

 

4. Layrs Control 2: Layrs Control 2 is a free Photoshop plugin which can help you make 

your editing process a lot less complicated by offering a way to keep your layers organised. 

 

 
Figure 12: Layrs Control 2 lets you better organise your Photoshop layers. 

It consists of 7 scripts: Layer Name Editor, Remove Unused Effects, Flatten All Layers Effects, 

Delete Empty Layers, Rasterize Smart Objects, Find Similar Files/Folders, and Convert to 

Smart Object.  
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5. Luminar (Formerly Luminar Flex): Luminar is one of the most advanced AI-powered 

photo editing plugins on the market. If you don’t like spending much time working on a 

colour grade and overall image enhancements, this is undoubtedly the best Photoshop 

plugin.  

 

Figure 13: Luminar 4 is another great Photoshop plugin for those who want impressive 

enhancements in minimal time. 

It delivers great results in minimal time. Formerly known as ‘Luminar Flex’, this plugin 

also offers AI Sky Enhancer, Smart Tone, and other Exclusive Creative Filters you can 

choose from. Every filter supports its own mask and blending modes, enabling you to take 

control and be more precise when editing your photos. 

6. Aurora HDR: The Aurora plugin is one of the best choices out there when it comes to 

creating HDR images. It is suitable for both Mac & Windows and offers an easy-to-use 

interface combined with advanced editing options. 

 

 
Figure 14: Skylum Aurora HDR lets you create natural-looking HDR images 

Aurora HDR also makes it really easy for you to end up with a natural-looking HDR image – 

something which can be very tricky with other plugins.  
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7. Boris FX Optics: New for Photoshop, the Optics plugin from Boris FX is a massive 

collection of lens flares, film looks, gobo patterns, lighting, and particle effects. If you 

want to make images look cinematic, add beautiful glows, or do full-blown photo 

manipulations. 

 

 
Figure 15: The Optics plugin snippet from Boris FX 

Boris FX has been developing video effects software for over 20 years and now brings 

its award-winning tools to Photoshop. Optics is value-packed with 174 filters, 1000’s of 

creative presets, and a powerful set of masking tools. 

 

8. Infinite Colour: Infinite Colour is a smart colour grading tool that creates a unique look 

by randomizing a set of adjustment layers and adding them to your images. 

 

 
Figure 16: Infinite Colour contains an infinite number of colour possibilities. 

The cool thing about this plugin is that the colours you create will be yours and yours alone 

because it contains an infinite number of colour possibilities. 
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9. Focus: If you take a breather from the ordinary and want to experiment more, then Focus 

is the right plugin for you. It’s designed to easily create selective focus, lens blur, motion 

blur and tilt-shift effects. 

 
Figure 17: Focus includes effects like motion blur and tilt-shift. 

10. RH Hover Colour Picker: It’s a modern, fast, discreet version of the Colour Picker. 

 

 
Figure 18: RH Hover is like the colour picker, only better. 

Aside from the fact that it simply looks much nicer, this plugin has another significant 

advantage: it can hide away from you while you’re painting and only comes back when you 

hover over its minimized version. 
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11. Blow up 3: This plugin is quite a gem to discover and it could be indispensable if you’re 

dealing with print. It’s an award-winning piece of enlargement software that makes it 

possible to easily make your photo bigger in size without sacrificing quality. 

 
Figure 19: Blow Up is a great Photoshop plugin for resizing images. 

Blow Up’s interface is simple and user-friendly with three main tabs to choose from: Crop, 

Crop & Resize, and Stretch. Another great advantage is that this one is compatible with both 

Windows and Mac. 

 

12. Noiseless:  

 

 
Figure 20: Noiseless can save your low-light images from the going in the bin. 

This is a great piece of software you can use to save your low-light images from being tossed 

out. This plugin automatically detects the noise in your photos and removes it. After that, it 

runs a second algorithm which is needed to add the detail back in. You can also take advantage 

of the adjustments panel and refine the noise reduction according to your expectations. 

The bad news is it’s not compatible with Windows. 
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How to Install Photoshop Plugins 

 

Here’s how you can install your new Photoshop plugin on a Windows PC in just a few simple 

steps: 

• Download the plugin itself 

• Extract the plugin you downloaded (most of them come in a RAR or ZIP folder for 

convenience) 

• Copy the entire folder that contains all the plugin files 

• Now you need to access your Adobe folder (Drive C for Windows and Applications 

for Mac) 

• Go to the Plugin folder 

• Paste the plugin you downloaded inside the “Plugins” folder 

• Start Photoshop and Test the new plugin you have just installed 

 

Where are plugins located in Photoshop? 

If you’re having trouble finding the Photoshop plugins after you’ve installed them, 

here’s some information from Adobe that should help. 

 

First you need to located the plugin folders: 

• Version specific location: Will only load the installed plug-in for a specific version of 

Photoshop. 

• Shared Creative Cloud Location: Will load the plug-in for all installed versions of 

Photoshop without having to reinstall the plug-in. 

 

Version specific location 

 

macOS: If you installed to the Photoshop version-specific location, the Photoshop plugins 

folder is located here: 

Hard Drive/Applications/[Photoshop version]/Plug-ins 

 

Windows: If you installed to the Photoshop version-specific location, the Photoshop plugins 

folder is located here: 

Hard Drive\Program Files\Adobe\[Photoshop version]\Plug-ins 

 

Shared Creative Cloud Location 

 

macOS: If you installed to the shared Creative Cloud location, the Photoshop plugins folder 

is located here:  

Hard Drive/Library/Application Support/Adobe/Plug-Ins/CC 

 

Additionally, the Camera Raw plugin is located in a common plug-ins folder, which 

Photoshop, Adobe Bridge, and Photoshop Elements share: 

Hard Drive/Library/Application Support/Adobe/Plug-Ins/[Photoshop version 

number]/File Formats. 
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Windows: If you installed to the shared Creative Cloud location, the plug-ins folder is 

located here: 

Hard Drive\Program Files\Common Files\Adobe\Plug-Ins\CC 

 

Additionally, the Camera Raw plugin is located in a common plug-ins folder, which 

Photoshop,  

Adobe Bridge, and Photoshop Elements share: 

Hard Drive\Program Files\Common Files\Adobe\Plug-Ins\[Photoshop version 

number] 
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Self-Check Sheet 1 Select the image editing tool 
 

True/False Questions: 

1. Adobe Photoshop is primarily used for managing and editing large photograph collections. 

2. Canva is a web-based platform for creating professional-looking designs like social media 

graphics and presentations. 

3. InPixio is a photo editing software that primarily offers basic editing tools like cropping 

and resizing. 

4. GIMP is an open-source alternative to Adobe Photoshop, providing similar features for 

image editing. 

5. Adobe Lightroom is known for its advanced tools in 3D rendering and digital painting. 

6. Plugins seamlessly integrate into the Photoshop interface, often appearing as additional 

menu options or panels. 

7. Photoshop plugins are exclusively developed by Adobe, without any third-party 

contributions. 

8. Adobe Photoshop plugins cannot enhance the software's existing functionality and 

features. 

9. Camera Raw is a plugin used for managing and organizing large photograph collections. 

10. Installing plugins manually involves downloading, extracting, copying, and pasting the 

plugin files into the appropriate Photoshop plugin folder. 

 

Short Questions: 

1. What is the purpose of image processing software? 

2. Name two open-source alternatives to Adobe Photoshop. 

3. What is the purpose of Adobe Lightroom? 

4. Why is compatibility an important consideration when selecting image processing 

software? 

5. How can plugins enhance the functionality of Adobe Photoshop? 

6. Name two types of plugins that extend Adobe Photoshop's capabilities. 

7. What is the advantage of using third-party plugins? 

8. How can users test the compatibility of a plugin with Adobe Photoshop? 

9. What is the purpose of the Camera Raw plugin? 

10. Describe the installation process for Photoshop plugins on Windows. 
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Answer Key 1 Select the image editing tool 
True/False Answers: 

1. False 

2. True 

3. False 

4. True 

5. False 

6. True 

7. False 

8. False 

9. False 

10. True 

 

Short Question Answers: 

1. The purpose of image processing software is to edit and manipulate images for various 

purposes, including retouching, colour correction, and special effects. 

2. Two open-source alternatives to Adobe Photoshop are GIMP (GNU Image 

Manipulation Program) and Krita. 

3. Adobe Lightroom is primarily used for managing, enhancing, and organizing large 

photograph collections. 

4. Compatibility is important to ensure that the software works seamlessly with your 

operating system and other software tools. 

5. Plugins enhance the functionality of Adobe Photoshop by adding new tools, effects, and 

features beyond what's available by default. 

6. Two types of plugins are filter plugins and brush plugins. 

7. Third-party plugins are developed by external developers or companies and expand the 

range of creative options in Adobe Photoshop. 

8. Users can test plugin compatibility by using trial versions or demos and experimenting 

with the plugin's tools and features. 

9. The Camera Raw plugin is used to edit and enhance raw images before they are 

processed further. 

10. The installation process for Photoshop plugins on Windows involves downloading, 

extracting, copying, and pasting the plugin files into the appropriate plugin folder 

within the Adobe directory. 
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Activity Sheet 1 Selecting the Right Image Processing Software 
 

Activity 1: Selecting the Right Image Processing Software 

 

Objective: To understand the factors to consider when selecting image processing software. 

 

Instructions: 

1. Read the section on "Selecting Image Processing Software" in the information sheet. 

2. Imagine you are a professional Graphic Designer looking to invest in image processing 

software. Answer the following questions: 

a. What is the purpose of the software you need? 

b. List three features you require from the software. 

c. Why is ease of use an important consideration for you? 

d. What is the significance of compatibility with your operating system? 

e. How would you ensure that the software's performance meets your needs? 

f. Why is customer support and documentation important for you? 

g. Consider your budget and describe how it influences your choice of software. 

h. Do you have any industry-specific needs that the software should address? 

i. Why is researching the reputation and reviews of software important? 

j. How would you take advantage of trial versions or demos to make an informed 

decision? 

3. Prepare a presentation on this and present to your instructor/audience. 

 

Activity 2: Exploring Photoshop Plugins 

 

Objective: To learn about the functionality and benefits of Photoshop plugins. 

 

Instructions: 

1. Read the section on "Installing necessary plugins" and "Popular Types of Photoshop 

Plugins" in the Information sheet. 

2. Choose one of the Photoshop plugins mentioned in the content (e.g., ON1 Effects, 

Luminar, Camera Raw). 

3. Research further about the chosen plugin on the internet. 

4. Write a brief description of the chosen plugin, highlighting its main features, 

advantages, and how it can enhance your image editing workflow. 

5. Answer the following questions: 

a. What specific functionality does your chosen plugin provide? 

b. Is the plugin developed by a third-party or by Adobe? 

c. How does the plugin integrate into the Photoshop interface? 

d. What type of tasks or effects can the plugin help you achieve? 

e. In what scenarios or projects would you use this plugin? 

f. How can the plugin save you time and effort during your editing process? 

g. Are there any customization options or presets available with the plugin? 

h. How can you ensure the security and reliability of third-party plugins? 
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i. What are some potential considerations before installing and using a plugin? 

j. How does the chosen plugin align with your specific editing needs? 

6. Prepare a presentation on this and present to your instructor/audience. 

 

Activity 3: Installing and Testing a Photoshop Plugin 

 

Objective: To practice installing a Photoshop plugin and testing its functionality. 

 

Instructions: 

1. Choose one of the plugins mentioned in the content (e.g., Camera Raw, ON1 Effects, 

Luminar) to install and test. 

2. Follow the provided instructions to install the chosen plugin on your computer. 

3. Launch Adobe Photoshop and open an image you want to edit. 

4. Use the installed plugin to apply an effect, adjustment, or enhancement to the image. 

5. Take a screenshot of the edited image with the applied plugin effect. 

6. Write a brief description of the effect you applied and the steps you took to achieve it. 
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Learning Outcome 2: Edit Image using editing tool 

Assessment Criteria 

 

1. Image is opened in layer and be aware of legislation. 

2. Layers are added to the image as required.  

3. Format, colour, brushes, effects, and swatches are applied as 

required.  

4. Optimized and previewing of Image is demonstrated. 

5. Image is exported as required 

Conditions and 

Resources 

 

1. Applicable tools, utensils, and equipment as prescribed by 

competency standards. 

2. Supply materials  

3. Relevant ingredients  

4. CBLM related to the learning outcome. 

5. Instructions, job sheets, activity sheets, and standard operating 

procedures  

6. Personal protective equipment  

7. Module/reference 

Contents 1 Identifying Graphic Design Objects. 

2 Understanding Smart Objects vs Normal Layers. 

3 Legislation. 

4 Working with Layers. 

5 Apply Format, colour, brushes, effects, and swatches. 

6 Slicing Objects for Web Optimization. 

7 Image Export. 

Training Materials 

 

1. CBLM 

2. Handouts 

3. Books, Manuals  

4. Module/ Reference  

5. Paper  

6. Pen 

Assessment Methods 

 

1. Written Test 

2. Demonstration 

3. Oral Questioning   
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Learning Experience 2: Edit Image using editing tool 

 

You must perform the learning steps below to achieve the objectives stated in this learning 

guide. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Students will ask the 

instructor about use image 

editing software. 

1. The instructor will provide the learning materials for` 

edit image using editing tool. 

2. Read the Information sheet/s 

2. Information Sheet No 2: Edit Image using editing tool. 

 

▪ Identifying Graphic Design Objects. 

▪ Understanding Smart Objects vs Normal Layers. 

▪ Legislation. 

▪ Working with Layers. 

▪ Slicing Objects. 

▪ Performing Image Manipulation - Apply Format, 

colour, brushes, effects, and swatches, etc. 

▪ Image Export. 

3. Complete the Self-Checks & 

Answer key sheets. 

3. Self-Check No 2: Edit Image using editing tool. 

 

Answer key No 2: Edit Image using editing tool. 

4. Read the Job/ Task sheet and 

Specification Sheet  

4. Job/ task sheet and specification sheet  

 

Job Sheet 1: Image Editing for Website Use 

 

Specification Sheet 1: Image Editing for Website Use 
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Information Sheet 2 Edit Image using editing tool 
 

Learning Objective: After completion of this information sheet, the learners will be able to 

interpret the following contents: 

 

2.1 Identifying Graphic Design Objects. 

2.2 Understanding Smart Objects vs Normal Layers. 

2.3 Legislation. 

2.4 Working with Layers. 

2.5 Slicing Objects. 

2.6 Performing Image Manipulation - Apply Format, colour, brushes, effects, and swatches, 

etc. 

2.7 Image Export. 

 

2.1 Identifying Graphic Design Objects: 

 

 
To identify graphic design objects, you can follow these steps: 

▪ Understand the context: Familiarize yourself with the design project or brief to gain an 

understanding of the purpose and goals of the design. This will help you identify relevant 

graphic design objects. 

▪ Analyze the design: Take a closer look at the design composition and elements. Look 

for distinct shapes, lines, colours, and patterns that stand out. 

▪ Identify typography: Examine the text elements in the design. Note the typefaces, font 

styles, sizes, and hierarchy of the text. Typography plays a crucial role in graphic design. 

▪ Recognize imagery: Identify any photographic images, illustrations, or icons used in the 

design. Consider their subject matter, style, and how they contribute to the overall 

message. 

▪ Pay attention to logos and branding: Look for logos or branding elements, such as 

company logos, trademarks, or specific brand colours and symbols. These elements often 

serve as key identifiers in a design. 
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▪ Notice graphical elements: Observe graphical elements like shapes, lines, and patterns. 

They can be abstract or representational, adding visual interest and structure to the 

design. 

▪ Evaluate composition: Assess the overall layout and arrangement of elements within 

the design. Note the use of grids, alignment, balance, and proximity to create a visually 

pleasing composition. 

▪ Consider visual hierarchy: Identify the visual hierarchy in the design. Notice which 

elements are emphasized, such as headings, subheadings, or important information, and 

how they are differentiated from less prominent elements. 

▪ Examine colour usage: Pay attention to the colour palette used in the design. Note the 

dominant colours, complementary colours, and any colour schemes or gradients 

employed to convey a specific mood or enhance visual appeal. 

▪ Look for interactive elements: If the design includes interactive components, such as 

buttons, navigation menus, or user interface elements, identify them and consider their 

functionality. 

 

2.1.1 Creating Basic Shapes 

 

To create basic shapes in Adobe Photoshop, you can use the shape tools available in the 

toolbar. Here's a step-by-step guide to creating some of the shapes you mentioned: 

 

a. Circle: 

 

• Select the Ellipse Tool from the toolbar (shortcut: 

U). 

 

• Click and drag on the canvas while holding the Shift 

key to create a perfect circle. 

 

b. Triangle: 

 

• The Star Tool works in a similar way as the Polygon 

Tool. The first step is to look for it in the Toolbar. 

Go to the Rectangle Tool, right-click on the 

rectangle icon and a submenu appears. Select the 

Star Tool, represented with a star icon.  

 

 

 

Figure 21: Creating Circle Shape. 

Figure 22: Creating Triangle Shape. 
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• Once you’ve selected the Star Tool, your cursor changes to a 

plus-like sign with a dot in the middle. Bring it to your 

artboard and click once. The Star Settings dialog box pops 

up. In the Radius fields, enter 200 in the field that says 

Radius 1, and 100 in the field that says Radius 2. In the Sides 

field, change it to 3, and click the OK button, a triangle 

appears. 

 

 

• In the Options bar at the top, set the Sides option to 3. 

• Click and drag on the canvas to create a triangle. 

 

c. Square/Rectangle: 

 

• First, look for the Rectangle Tool, which is represented by an icon of a rectangle shape. 

Or press M on the keyboard. With the Rectangle Tool, you can draw a square or a 

rectangle. Both can give you a right-angle triangle. 

 

• To draw a square, press shift on your keyboard, 

and at the same time with your mouse, click and 

drag away from where you first clicked. As you 

drag further, you will see a square forming. The 

further you drag, the bigger the square. Release 

your mouse and shift key once you’ve reached 

your desired square size. 

• Click and drag on the canvas to create a rectangle. 

• To create a perfect square, hold the Shift key while dragging. 

 

d. Rhombus/Trapezoid/Pentagon/Hexagon/Octagon: 

 

• Select the Polygon Tool from the toolbar (click and hold on the Rectangle Tool to access 

it). 

• In the Options bar at the top, set the Sides option to the desired number (4 for a rhombus, 

4 for a trapezoid, 5 for a pentagon, etc.). 

• Click and drag on the canvas to create the shape. 

 

e. Oval: 

 

• Select the Ellipse Tool from the toolbar. 

• Click and drag on the canvas to create an ellipse (holding the Shift key will constrain it 

to a circle). 

• To create a perfect oval, click and drag while holding the Shift key and the Alt key 

(Option key on Mac). 

 

Figure 23: Shape Points. 

Figure 24: Rectangle Shape. 
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2.2 Understanding Image Formats: JPEG, PNG, GIF, and PSD 

 

Images are a fundamental part of digital communication and visual representation. They 

play a vital role in conveying information, expressing emotions, and enhancing the 

overall aesthetic appeal of various digital platforms. Different image formats serve 

distinct purposes, offering a balance between image quality, file size, and transparency. 

We will explore some of the most used image formats: JPEG, PNG, GIF, and PSD. 

 

 

▪ JPEG (Joint Photographic Experts Group): 

 

JPEG is one of the most widely used image formats, known for its efficient compression 

algorithm. It is particularly suitable for photographs and images with subtle colour 

gradients. JPEG compression reduces file sizes while maintaining acceptable image 

quality. However, it is considered a lossy compression format, meaning that some image 

information is discarded during compression, resulting in a minor loss of image quality. 

JPEG is commonly used for web images, digital photography, and presentations. 

 

▪ PNG (Portable Network Graphics): 

 

PNG is a popular image format that offers lossless compression, preserving image quality 

without compromising file size. PNG supports transparent and non-transparent 

backgrounds, making it ideal for images with complex backgrounds or intricate details. 

It is widely used for images that require a high degree of detail, such as logos, icons, and 

images with text. PNG also supports different colour depths, including 8-bit and 24-bit 

colours, allowing for greater colour accuracy. 

 

▪ GIF (Graphics Interchange Format) 

 

GIF is a format known for its support of animations and short looping videos. It uses 

lossless compression for images with limited colour palettes, making it suitable for 

graphics with simple shapes and text. GIFs are widely used on the internet for sharing 

animations, memes, and simple graphics. They are especially popular on social media 

platforms due to their ability to convey emotions or messages in a playful and engaging 

manner. 

 

▪ PSD (Photoshop Document): 

 

PSD is a proprietary file format created by Adobe Photoshop, a renowned image editing 

software. PSD files retain all layers, adjustments, and other elements of an image, 

allowing for non-destructive editing. This format is ideal for professional graphic 

designers and photographers who need to work on complex compositions. PSD files are 

often used for creating and editing images with multiple layers, effects, and various 
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design elements. While PSD files can be quite large due to their complexity, they provide 

the flexibility needed for advanced image manipulation. 

 

▪ Choosing the Right Format: 

 

The choice of image format depends on the intended use and the specific characteristics 

of the image. Here are some considerations to help you choose the appropriate format: 

 

➢ JPEG: Use JPEG for photographs and images with smooth colour gradients. It's suitable 

for web images, digital photography, and presentations where a balance between image 

quality and file size is important. 

➢ PNG: Opt for PNG when you need high-quality images with transparency. It's ideal for 

logos, icons, and images with intricate details that require accurate rendering. 

➢ GIF: Choose GIF for short animations, memes, and simple graphics. It's great for 

conveying messages in a playful and engaging way, especially on social media. 

➢ PSD: Use PSD when you need to work on complex compositions and retain all layers 

and adjustments for future editing. It's essential for professional graphic designers and 

photographers who require advanced image manipulation capabilities. 

 

2.3 Legislations:  

 

In today's digital landscape, the creation, distribution, and use of images have become an 

integral part of communication, art, and commerce. To ensure fair use, protect intellectual 

property, and maintain ethical standards, various legislation and legal frameworks have 

been established to govern the use of images. These regulations help artists, 

photographers, designers, and the public navigate the complexities of image usage and 

distribution. Here are key points about legislation related to images: 

 

▪ Copyright Act: The Copyright Act provides creators with exclusive rights over their 

creative works, including images. It safeguards the originality of images and prevents 

unauthorized copying, distribution, and modification. Creators automatically hold 

copyright over their images upon creation, but registration strengthens legal claims in 

case of disputes. Users should seek permission or licenses before using copyrighted 

images for commercial purposes. 

 

▪ Intellectual Property Rights (IPR) Laws: Intellectual property rights encompass 

copyright, trademark, patent, and trade secret protection. IPR laws safeguard the rights 

of creators and inventors, encouraging innovation and creativity. Images can be 

copyrighted, and logos, brands, and distinctive designs may be protected as trademarks. 

 

▪ Digital Millennium Copyright Act (DMCA): The DMCA addresses digital copyright 

infringement issues, especially on the internet. It provides a framework for content 

owners to send takedown notices to platforms hosting infringing content. Online 
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platforms that comply with takedown notices can avoid legal liability for hosting 

copyrighted images without permission. 

▪ Relevant Sections of ICT Act: The ICT Act deals with various aspects of digital 

communication and technology, including online content. Some provisions pertain to the 

distribution of offensive, harmful, or defamatory content, which can include images. It's 

crucial to understand the boundaries of responsible image sharing and avoid violating 

these provisions. 

▪ Relevant Sections of National Cyber Policy: National cyber policies often include 

guidelines for safe and responsible online behavior. They may address issues such as 

cyberbullying, harassment, privacy, and data protection. Ensuring that images are used 

respectfully and ethically aligns with these policies. 

▪ Fair Use Doctrine: Many legal systems incorporate the concept of fair use or fair 

dealing, which allows limited use of copyrighted material without permission for 

purposes like criticism, commentary, news reporting, education, and research. However, 

the definition of fair use varies by jurisdiction and context, so it's essential to understand 

its nuances. 

▪ Creative Commons Licenses: These licenses provide a flexible way for creators to grant 

permissions for their works. Different types of Creative Commons licenses allow varying 

degrees of use, modification, and distribution. Users can legally use images under these 

licenses if they adhere to the license terms. 

▪ Model Release and Publicity Rights: When using images of individuals, it's crucial to 

obtain a model release if the image will be used for commercial purposes. Publicity rights 

also protect individuals' images from unauthorized commercial exploitation. 

▪ Ethical Considerations: Apart from legal obligations, ethical considerations guide 

image usage. Respecting the integrity of the subject matter and avoiding 

misrepresentation or manipulation is crucial. Ethical use aligns with broader societal 

values and promotes responsible image sharing. 

In practice, as a graphic designer in Bangladesh, you should take the following 

precautions: 

 

➢ Always use images, fonts, and other resources that you have the legal right to use, 

either through licensing or proper authorization. 

➢ Avoid using copyrighted materials without obtaining permission or a license, as it 

could lead to legal issues. 

➢ Be cautious about using images or content that could be defamatory or offensive under 

the ICT Act. 

➢ Follow best practices for data protection and cybersecurity when working with digital 

files and client information. 

➢ Stay informed about changes in legislation and policies related to graphic design, 

copyright, and intellectual property rights. 
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2.4 Understanding Smart Objects Vs Normal Layers 

 

Understanding the difference between smart objects and normal layers is essential for 

efficient and flexible image editing. Let's delve into their definitions and characteristics: 

Normal Layers: Normal layers in image editing software, such as Adobe Photoshop, are 

the fundamental building blocks of compositions. Each layer consists of visual content 

that can be edited independently of others. They can contain various elements like 

images, text, shapes, or adjustments. 

Key points about normal layers: 

▪ Independent Editing: Normal layers allow you to 

apply different transformations, blending modes, 

opacity adjustments, and layer-specific effects. 

▪ Pixel-Based: The content within a normal layer is 

rasterized, meaning it's composed of pixels. Scaling 

or resizing can result in a loss of image quality. 

▪ Editing Limitations: Once you apply a 

transformation or effect directly to a normal layer, it 

becomes permanent and can't be easily modified 

without using tools like masks or adjustment layers. 

Smart Objects: Smart objects, on the other hand, are special types of layers that retain 

the original source content and allow for non-destructive editing. A smart object can be 

a raster image, vector graphic, or even a nested composition. 

Key points about smart objects: 

▪ Source File Preservation: Smart objects link to the 

original source file or embed it within the layer. This 

preserves the original data, including resolution and 

vector information. 

▪ Non-Destructive Editing: Smart objects enable non-

destructive transformations and adjustments. You can 

scale, rotate, apply filters, or add effects without 

altering the original data permanently. 

▪ Editability: You can double-click on a smart object to 

open it as a separate document, make edits, and save changes. These edits will 

automatically update in all instances of the smart object in your composition. 

Figure 25: Layers Panel - Normal Layers. 

Figure 26: Convert to Smart Object. 
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▪ Lossless Scaling: Smart objects can be resized multiple times without losing quality 

because the transformations are recalculated based on the original source. 

▪ Filter and Adjustment Flexibility: Smart objects allow you to apply filters, adjustment 

layers, and layer styles that can be modified or removed at any time. 

▪ File Size Considerations: Since smart objects retain the original source data, they may 

increase file size compared to normal layers. 

 

2.5 Working with Layers 

 

Working with layers in Adobe Photoshop is 

fundamental for creating complex and non-

destructive image compositions. Layers allow 

you to stack, organize, and edit different 

elements of your design or photograph 

independently. Here's a step-by-step guide on 

working with layers in Photoshop: 

 

 
Figure 27: Working with Layers. 

 

2.5.1 Creating Layers: 

▪ To create a new layer, go to the Layers panel (usually located on the 

right side of the interface) and click on the "Create a new layer" 

button at the bottom. Alternatively, you can use the shortcut 

Shift+Ctrl+N (Shift+Cmd+N on a Mac). 

▪ You can also create a new layer by duplicating an existing layer. 

Select the layer you want to duplicate and press Ctrl+J (Cmd+J on 

a Mac). 

2.5.2 Layer Ordering: 

▪ Arrange the layers in the desired order by clicking and dragging them up or down within 

the Layers panel. The layers at the top appear in front of the layers below. 

2.5.3 Layer Visibility: 

▪ Toggle the visibility of a layer by clicking the eye icon next to it in the Layers panel. This 

allows you to show or hide specific layers to view the impact on the overall composition. 

 

 

Figure 28: Creating Layers. 
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2.5.4 Layer Opacity: 

▪ Adjust the opacity of a layer to control its transparency. Use the Opacity slider in the 

Layers panel or enter a specific value to make the layer more or less transparent. Lower 

opacity values make the layer more see-through. 

2.5.5 Layer Blending Modes: 

▪ Blending modes control how a layer interacts with the layers below it. Select a layer and 

experiment with different blending modes from the drop-down menu in the Layers panel 

to achieve different visual effects. 

2.5.6 Layer Masks: 

▪ Layer masks enable selective editing by hiding or revealing portions of a layer. To add a 

layer mask, select the layer and click on the "Add layer mask" button at the bottom of the 

Layers panel. You can then use brushes or selection tools to paint on the mask to hide or 

reveal parts of the layer. 

2.5.7 Adjustment Layers: 

▪ Adjustment layers allow you to apply non-destructive edits to your image. Click on the 

"Create new fill or adjustment layer" button at the bottom of the Layers panel and select 

the desired adjustment (e.g., Levels, Curves, Hue/Saturation). These adjustment layers 

affect all the layers below them and can be modified or removed at any time. 

2.5.8 Grouping Layers: 

▪ Grouping layers helps organize and manage complex compositions. Select the layers you 

want to group (hold Shift and click on the layers) and press Ctrl+G (Cmd+G on a Mac) 

or click on the "Create a new group" button at the bottom of the Layers panel. You can 

then collapse or expand the group to hide or show its contents. 

2.5.9 Layer Styles: 

▪ Layer styles provide additional effects like drop shadows, gradients, strokes, and more. 

Double-click on a layer to open the Layer Style dialogue box, or right-click on a layer 

and choose "Blending Options" to access various styling options. 

2.5.10 Smart Objects: 

▪ Convert layers to smart objects to maintain non-destructive editing capabilities and 

preserve the original source content. Right-click on a layer, select "Convert to Smart 

Object" or go to the Layer menu and choose "Smart Objects." 
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2.6 Slicing Objects 

Slicing objects involves dividing an image or design into smaller, optimized sections 

called slices. This technique is commonly used to improve web page loading times and 

optimize file sizes. Here's a step-by-step guide on slicing objects for web optimization in 

Adobe  

Photoshop: 

 

➢ Open your image or design file in Photoshop. 

➢ Select the Slice Tool: In the toolbar, click and hold on the Crop Tool (or press C) to 

reveal the hidden Slice Tool. Click on the Slice Tool to activate it. 

➢ Define the Slices: 

• Automatic Slicing: With the Slice Tool selected, go to the options bar at the top. 

Choose "Auto Slice" to automatically divide the image into slices based on 

certain criteria like equal size or guidelines. 

• Manual Slicing: To manually define slices, click and drag the Slice Tool across 

the area you want to slice. Hold Shift while dragging to create square slices. 

➢ Adjust Slice Properties: 

• For each slice, you can adjust properties like URL links, alternative text, and 

optimization settings. Select a slice and modify its properties in the Slice 

Options panel (usually located below the Layers panel). Specify a destination 

URL, add alt text for accessibility, and choose optimization settings. 

➢ Export Slices: 

• To export the slices, go to File > Export > Save for Web (Legacy) or use the 

shortcut Alt+Shift+Ctrl+S (Option+Shift+Cmd+S on a Mac). 

• In the Save for Web dialog box, select the desired file format (e.g., JPEG, PNG, 

GIF). 

Figure 29: Slicing Objects. 
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• Adjust the optimization settings to balance file size and image quality. Consider 

factors like colour palette, dithering, and compression. You can preview the 

output in real-time and compare different settings. 

• Specify the destination folder and file name, and click "Save" to export the 

sliced images. 

➢ HTML Generation (Optional): 

• If you want to generate HTML code for the sliced image, you can do so in the 

Save for Web dialog box. Click on the "Save" button, and in the next dialog, 

select "HTML and Images" from the "Save as type" dropdown. This creates an 

HTML file with the necessary code to display the sliced image on a webpage. 

➢ Implement the Sliced Image: 

• Once you have the sliced and optimized images, you can incorporate them into 

your webpage or design. Use the HTML code generated or manually insert the 

optimized image slices, ensuring they link to the appropriate URLs and contain 

alt text if applicable. 

 

2.7 Performing Image Manipulation - Apply Format, colour, brushes, effects, and 

swatches, etc 
 

Performing image manipulation in Adobe Photoshop involves various techniques and 

tools to achieve desired results. Here's a breakdown of common image manipulation 

tasks: 
 

2.7.1 Image Resize: 

 

▪ Open the image in Photoshop. 

▪ Go to the "Image" menu and select "Image Size." 

▪ In the dialog box, you can adjust the dimensions of the image by entering specific values 

or using percentage scaling. 

▪ Make sure the "Resample" option is checked to maintain image quality while resizing. 

▪ Click "OK" to apply the changes. 

 

 

 

 

 

 

 

 

 

 
Figure 30: Image Resize. 
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2.7.2 Colour Correction: 

 

▪ Open the image in Photoshop. 

▪ Utilize adjustment layers to modify the image's colour balance, brightness, contrast, and 

saturation. 

▪ Go to the "Layer" menu and select "New Adjustment Layer," then choose the adjustment 

you want to make (e.g., "Levels," "Curves," "Hue/Saturation," etc.). 

▪ Adjust the sliders or curves in the adjustment layer properties panel to achieve the desired 

colour correction. 

▪ Experiment with different adjustments until you achieve the desired result. 

  

Original Image Final Result 

Figure 31: Color Correction. 
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2.7.3 Retouch: 

 

▪ Use retouching tools like the "Spot Healing Brush," 

"Healing Brush," or "Clone Stamp" tool to remove 

imperfections or enhance certain areas. 

▪ Select the desired retouching tool from the toolbar. 

▪ Adjust the brush size, hardness, and opacity in the 

options bar according to your needs. 

▪ Alt-click (Option-click on Mac) on a clean area near 

the imperfection to sample it as a source. 

▪ Click and brush over the imperfection or area you 

want to retouch, blending it with the surrounding 

pixels. 

 

2.7.4 Crop: 

 

▪ Open the image in Photoshop. 

▪ Select the Crop Tool from the toolbar (shortcut: C). 

▪ Click and drag to define the desired crop area on the image. 

▪ Adjust the crop area by dragging the handles or entering specific values in the options 

bar. 

▪ Press Enter (Return on Mac) or click the checkmark in the options bar to apply the crop. 

 

 

 

 

 

 

 

 

2.7.5 Filter: 

 

▪ Open the image in Photoshop. 

▪ Go to the "Filter" menu and explore the various filter options available. 

▪ Select a filter category and choose a specific filter to apply. 

▪ Adjust the filter settings if necessary to achieve the desired effect. 

▪ Click "OK" to apply the filter. 

 

2.7.6 Optimize for Web: 

 

▪ Open the image in Photoshop. 

▪ Go to the "File" menu and select "Export" or "Save for Web" (depending on your 

Photoshop version). 

Selecting the Crop Tool. 

 

Figure 32: Retouch Tool. 

Figure 33: Crop Tool. 
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▪ In the Export/Save for Web dialog box, adjust the settings to optimize the image for web 

use. 

• Set the desired file format (JPEG, PNG, GIF), quality, resolution, and image 

size. 

• Preview the optimized image and make any necessary adjustments. 

• Click "Save" or "Export" to save the optimized image. 
 

2.7.7 Colour panel 
 

The Colour panel (Window > Colour) displays the colour values for the current 

foreground and background colours. Using the sliders in the Colour panel, you can edit 

the foreground and background colours using different colour models. You can also 

choose a foreground or background colour from the spectrum of colours displayed in the 

colour ramp at the bottom of the panel. 
 

The Colour panel may display the following alerts when you select a colour: 

• An exclamation mark inside a triangle  appears above the left corner of the colour 

ramp when you choose a colour that cannot be printed using CMYK inks. 

• A square  appears above the left corner of the colour ramp when you choose a colour 

that is not web-safe. 

 
Figure 34: Colour panel. 

A. Foreground colour B. Background colour C. Slider D. Colour ramp 
 

Change the colour model of the Colour panel sliders: To change the colour panel 

sliders' colour model, choose the Sliders option from the Colour panel menu. 
 

Change the spectrum displayed in the Colour panel:  Choose an option from 

the Colour panel menu — RGB Spectrum, CMYK Spectrum, or Grayscale Ramp, to 

display the spectrum of the specified colour model. To change the spectrum displayed in 

the Colour panel, you can select: 
 

• Current Colours: To display the spectrum of colours between the current foreground 

and background colour. 

• Make Ramp Web Safe: To display only web-safe colours. 
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Select a colour in the Colour panel 
 

➢ Click the foreground or background colour box in the Colour panel to make it active 

(outlined in black). When the background colour box is active in the Colour panel, 

the Eyedropper tool changes the background colour by default. 
 

➢ Do one of the following: 

• Drag the colour sliders. By default, the slider colours change as you drag. To 

turn off this feature, navigate to Preferences > General and deselect Dynamic 

Colour Sliders. 

• Enter values next to the colour sliders. 

• Click the colour selection box, choose a colour using the Colour Picker, and 

click OK. 

• Position the pointer over the colour ramp (the pointer becomes the eyedropper), 

and click to sample a colour. Alt-click to apply the sample to the non-active 

colour selection box. 

Apply swatches to layers: To apply a colour swatch to text layers or shape layers, do 

any of the following: 
 

• Select one or more layers in the Layers panel and then click any of the swatches in the 

Swatches panel to apply it. 

• Drag a swatch from the Swatches panel onto the layer's content on the canvas area. 

• Drag a swatch from the Swatches panel onto a layer in the Layers panel.   
 

To apply a colour swatch to pixel layers, drag a swatch from the Swatches panel on a 

pixel layer in the Layers panel. Photoshop automatically creates a fill layer on top of 

the pixel layer. 

 

 
Figure 35: Apply swatches to layers. 
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Organize swatches into groups 

To organize swatches under a new group: 

▪ In the Swatches panel, click the Create New Group icon.  

▪ Specify a group name and click OK.  

▪ Drag a swatch or use the Shift key to select multiple swatches to drag them inside 

the Group. 

To create nested groups: 

▪ Select a group in the Swatches panel. 

▪ Drag the selected group and place it under another group.   

 

 
Figure 36: Organize swatches into groups. 

 

Working with brushes: The Brush tool allows you to paint on any layer, much like a 

real paintbrush. You'll also have different settings to choose from, which can help you 

customize it for different situations. Once you know how to use the Brush tool, you'll 

notice that many other tools, including the Eraser and the Spot Healing Brush, use a 

similar group of settings. 

 

Using the Brush tool 

 

▪ It's easy to use the Brush tool to paint in your document. Simply locate and select 

the Brush tool from the Tools panel, then click and drag in the document window to 

paint. You can also press the B key on your keyboard to select the Brush tool at any 

time.  
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Figure 37: Using the Brush tool. 

▪ To choose a different brush color, click the top-most color in the Color Picker 

Tool (this is known as the Foreground Color), then select the desired color from the 

dialog box.  

 

 
Figure 38: Color Picker Tool. 
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▪ You'll also be able to customize different settings for the Brush tool from 

the Control panel near the top of the screen. 

 

 
Figure 39: customize different settings for the Brush tool. 

 

Some of the settings you can adjust here include: 

• Brush Size: If you want to make the brush larger or smaller, click the Brush 

Picker drop-down arrow in the Control panel, then adjust the Size slider. You can also 

press the bracket keys [ ] to quickly increase or decrease the brush size. 

 

 
Figure 40: Brush Size 

• Hardness: If you want to make the brush edges harder or softer, you can adjust 

the hardness from the same drop-down menu. A harder brush will have clear, defined 

edges, whereas a softer brush will have blurry, less-defined edges. For most situations, 

we recommend setting the hardness to 50% or less because it will help to make 

individual brush strokes less obvious. 
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Figure 41: hardness of brush tool. 

• Brush Tip: If you want to create a unique effect, there are different brush tips to 

choose from in the same drop-down menu. Some of these are designed to mimic real-

life drawing tools like pens and markers, while others are simpler. 

 

 
Figure 42: Brush Effect 

• Opacity: By default, the opacity of your brush is set to 100%, meaning the brush will 

use the highest intensity. However, you can reduce the opacity of your brush to make 

it less intense. 
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Figure 43: Brush Opacity. 

 

2.8 Exporting Objects for the Web 

Exporting objects for the web involves saving individual elements from a design or image 

in a format optimized for web use. This allows for faster loading times and better 

compatibility across different browsers and devices. Here's a step-by-step guide on 

exporting objects for the web using Adobe  

Photoshop: 

▪ Open your image or design file in Photoshop. 

▪ Select the Object to Export: Use the selection tools (e.g., Marquee, Lasso, or Magic 

Wand) to select the specific object or element you want to export. Ensure that your 

selection encompasses only the desired object and doesn't include any unwanted parts. 

▪ Refine the Selection (Optional): Use Photoshop's selection tools or refine edge 

techniques (e.g., Select and Mask) to fine-tune the selection edges for smoother 

results. 

▪ Create a New Document (Optional): If the object you want to export is part of a larger 

composition and you wish to isolate it on a transparent background, create a new 

document with a transparent background before proceeding to the next steps. Use the 

"File" menu and select "New" to create a new document with the desired dimensions 

and a transparent background. 
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▪ Copy and Paste: With the object or element selected, copy it by pressing Ctrl+C 

(Cmd+C on a Mac). Then, paste it into the new document or an existing one by 

pressing Ctrl+V (Cmd+V on a Mac). 

▪ Position and Resize (if necessary): Adjust the position and size of the pasted object 

within the document using the Move Tool (V). You can also use the Transform 

options (Ctrl+T or Cmd+T) to resize, rotate, or scale the object as needed. 

▪ Export the Object: 

• Go to File > Export > Export As (or "Save for Web" in older Photoshop 

versions) or use the shortcut Ctrl+Shift+Alt+S (Cmd+Shift+Option+S on a 

Mac). 

• In the export dialog box, choose the desired format for the object, such as 

JPEG, PNG, or GIF, based on your specific needs. 

• Adjust the settings according to the format you selected. For example, for 

JPEG, you can adjust the quality slider to balance image quality and file size. 

For PNG, you can choose transparency options. 

• Specify the destination folder and file name for the exported object. 

• Click "Export" or "Save" to save the object in the desired format and location. 

▪ Repeat for Additional Objects: If you have multiple objects to export, repeat the steps 

above for each individual object, selecting, copying, and pasting them into separate 

documents or as separate layers within the same document. 

▪ Implement the Exported Objects: Once the objects are exported, you can use them in 

your web projects by incorporating them into your HTML and CSS code or using 

them in design software or web development tools. 

Remember to consider the appropriate file formats and settings for different types of objects, 

such as photographs, illustrations, icons, or logos, to achieve the best balance between image 

quality and file size for optimal web performance. 
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Self-Check Sheet 2 Edit Image using editing tool 
 

 
1. Which of the following is a graphic design object?       

a) Pixel   b) Layer   c) Filter   d) Brush 

 

2. What is the purpose of image processing software?  

a) Editing text in images    b) Creating 3D models  

c) Manipulating and enhancing images  d) Designing web layouts 

 

3. Smart objects in image processing software:  

a) Are non-editable and raster-based  

b) Allow for non-destructive editing and scaling without loss of quality  

c) Are used only for text editing  

d) Can be directly exported to web formats 

 

4. Which option best describes a normal layer?  

a) Allows for non-destructive editing  

b) Supports vector graphics only  

c) Cannot be rearranged within the layer stack  

d) Offers advanced 3D modeling features 

 

5. What is the purpose of working with layers in image processing software?  

a) To organize and manage different elements of an image  

b) To apply filters and effects  

c) To adjust the image resolution  

d) To optimize images for web loading 

 

6. Which of the following is a common technique for slicing objects for web 

optimization?  

a) Cropping     b) Resizing    

c) Cloning     d) Dividing an image into smaller parts 

 

7. When slicing objects for web optimization, what is the purpose of creating separate 

slices?  

a) To reduce image file size  

b) To apply filters and effects to individual slices  

c) To merge them into a single image file  

d) To convert them into vector graphics 

 

8. Which file format is commonly used for exporting sliced images for the web?  

a) JPEG   b) TIFF   c) GIF    d) SVG 
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9. Which of the following is a consideration when selecting image processing software? 

a) Price and availability    

b) Compatibility with specific operating systems  

c) Range of supported file formats  

d) All of the above 

 

10. What is the main advantage of using smart objects over normal layers?  

a) They allow for non-destructive editing  

b) They have a smaller file size  

c) They support 3D modeling features  

d) They offer advanced text editing capabilities 

 

11. Which tool is commonly used for selecting and manipulating individual layers in 

image processing software?  

a) Move tool   b) Brush tool   c) Crop tool   d) Gradient tool 

 

12. Which term refers to the process of arranging layers on top of each other in image 

processing software?  

a) Layer blending    b) Layer masking  

c) Layer stacking    d) Layer grouping 

 

13. When slicing objects for web optimization, what should be considered for maintaining 

visual consistency?  

a) Keeping each slice the same size  

b) Applying the same filter to each slice  

c) Aligning the edges of adjacent slices  

d) Using the same colour palette for each slice 

 

14. Which of the following is NOT a common method for selecting objects in image 

processing software?  

a) Magic Wand tool    b) Lasso tool    

c) Paint Bucket tool    d) Marquee tool 

 

15. Which technique is commonly used to create basic shapes in image processing 

software?  

a) Rasterizing   b) Dithering   c) Vectorization  d) Cloning 

 

16. When exporting objects for the web, which file format is commonly used for images 

that contain complex graphics and gradients?  

a) JPEG   b) PNG   c) GIF    d) SVG 

 

17. Which file format is suitable for transparent images, such as logos or icons?  

a) JPEG   b) PNG   c) GIF    d) SVG 

 



 

53 
 

18. Which file format supports animation and is commonly used for displaying short, 

looping animations on the web?  

a) JPEG   b) PNG   c) GIF    d) SVG 

19. When integrating graphic assets into webpages, which HTML element is commonly 

used to display an image?  

a) <image>   b) <picture>   c) <img>   d) <asset> 

 

20. Which attribute is used in the <img> tag to specify the source (URL or file path) of the 

image? a) src    b) alt    c) href    d) url 

 

21. Which attribute is used in the <img> tag to provide alternative text for the image, useful 

for accessibility and SEO purposes?  

a) src    b) alt    c) href    d) url 

 

22. When integrating graphic assets into webpages, which CSS property is commonly used 

to control the size of an image?  

a) width   b) height   c) size    d) scale 

 

23. Which CSS property is used to position an image within its containing element?  

a) align   b) position   c) float    d) display 

 

24. Which CSS property can be used to apply a background image to an element?  

a) background-image   b) image-source  

c) background-url   d) image-background 

 

25. When integrating graphic assets into webpages, which file format is commonly used 

for scalable vector graphics?  

a) JPEG    b) PNG   c) GIF   d) SVG 
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Answer Key 2 Edit Image using editing tool 
 

 

1. b) Layer. 

2. c) Manipulating and enhancing images. 

3. b) Allow for non-destructive editing and scaling without loss of quality. 

4. c) Cannot be rearranged within the layer stack. 

5. a) To organize and manage different elements of an image. 

6. d) Dividing an image into smaller parts. 

7. a) To reduce image file size. 

8. a) JPEG. 

9. d) All of the above. 

10. a) They allow for non-destructive editing. 

11. a) Move tool. 

12. c) Layer stacking. 

13. c) Aligning the edges of adjacent slices. 

14. c) Paint Bucket tool. 

15. c) Vectorization. 

16. b) PNG. 

17. b) PNG 

18. c) GIF 

19. c) <img> 

20. a) src 

21. b) alt 

22. a) width 

23. c) float 

24. a) background-image 

25. d) SVG 
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Job Sheet 1 Image Editing for Website Use 
 

Job Title: Image Editing for Website Use 

 

Objective: To edit an image for website use by cropping it to a specific ratio, applying color 

correction, and export it for web display. 

 

Duration: 2 hours 

 

Steps: 

 

Step 1: Open the Image 

1. Launch the image editing software. 

2. Open the image you want to edit. 

 

Step 2: Determine the Crop Ratio 

1. Identify the target aspect ratio for the image. 

2. Note down the pixel dimensions corresponding to the chosen ratio. 

 

Step 3: Crop the Image 

1. Select the Crop tool from the toolbar. 

2. Enter the pixel dimensions corresponding to the chosen aspect ratio. 

3. Adjust the crop box to frame the desired portion of the image. 

4. Apply the crop. 

 

Step 4: Apply Color Correction 

1. Use adjustment layers (e.g., Levels, Curves, Color Balance) to enhance the image's 

color and tone. 

2. Adjust sliders and curves to achieve the desired look. 

3. Adjust colour parameters. 

 

Step 5: Export the Edited Image 

1. Choose a destination folder to save the edited image. 

2. Select the appropriate file format and file extension. 

3. Confirm any additional settings (e.g., metadata, color profiles) and click "Save" or 

"Export." 

4. Open the exported image in a web browser to confirm its appearance. 
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Specification Sheet 1 Image Editing for Website Use 
 

Job Title: Image Editing for Website Use 

 

Necessary tools and equipment 

 

Sl. No 
Name of Tools & 

Equipment 
Specification Unit Quantity 

1 Computer Minimum Corei3 with 4GB 

RAM 

No. 
1 

2 Code Editor Any No. 1 

3 Software (Browser) 

Image editing software (e.g., 

Adobe Photoshop) - Latest 

Version 

No. 01 

4 Internet connections  High Speed No. 01 

 

Other Specifications: 

 

1. Aspect ratio for the image: 16:9. 

2. Pixel dimensions: 300. 

3. Color parameters: Adjust brightness, contrast, saturation, and color temperature to 

achieve the desired visual effect. 

4. File format: PNG for web use. 
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Review of Competency 
 

Below is your assessment rating for module Use Image Editing Software 

 

Assessment of Performance Criteria Yes No 

Appropriate image editing software is selected as required.   

Necessary plug-ins are installed and check other requirements.   

The image is opened in layers and be aware of the legislation.   

Layers are added to the image as required.    

Format, colour, brushes, effects and swatches are applied as 

required. 

  

Optimized and previewing of the Image is demonstrated.   

The image is exported as required.   

 

 

I now feel ready to undertake my formal competency assessment. 

 

Signed: 

 

Date: 
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Development of CBLM: 
 

The Competency Based Learning Material (CBLM) of ‘Use image editing software’ 

(Occupation: Web Design and Development for Freelancing, Level-3) for National Skills 

Certificate is developed by NSDA with the assistance of SIMEC System, ECF consultancy & 

SIMEC Institute JV (Joint Venture Firm) in the month of June 2023 under the contract number 

of package SD-9A dated 07th May 2023. 

 

Sl No. Name & Address  Designation Contact number  

1  Khondoker Ali Asgor Pavel Writer 01711 873 008 

2  Fatema  Editor 01912 464 747 

3  Md. Amir Hossain  Co-Ordinator 01631 670 445 

4  Mahbub Ul Huda Reviewer  01735490491 

 

 


